CHAPTER 4
Managing Databases with Sybase Central

About this chapter This chapter introduces Sybase Central, the Sybase database management
tool. It provides a brief introduction to using Sybase Central for managing
database properties.

Detailed instructions on using Sybase Central are available in the Sybase
Central online help. The online help is arranged as a set of how to windows
leading you step by step through database management tasks. In addition,
context sensitive Help is available to explain the different interface elements.
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Before you begin
Java behavior may differ

This chapter describes the Windows version of Sybase Central, which
requires Windows 95 or Windows NT. The Java Edition of Sybase
Central has similar but not identical features.
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Sybase Central and database management

Sybase Central and database management

Using Windows 95
or NT

Other systems
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Sybase Central is a database management tool that exposes Adaptive Server
Anywhere database settings, properties, and utilities in a graphical user
interface. Sybase Central is also used for managing other Sybase products,
including Adaptive Server Enterprise and PowerDynamo. This chapter
describes only how to use Sybase Central with Adaptive Server Anywhere
databases.

Database administration tasks typically fall into two categories:
¢ Tasks carried out by sending SQL statements to the database server.

¢  Tasks carried out by Adaptive Server Anywhere utilities.
Sybase Central provides an easy-to-use interface for both kinds of tasks.

For users with access to Windows 95 or NT, Sybase Central will make your
database administration tasks easier and more efficient.

For Adaptive Server Anywhere users not running Windows 95 or Windows
NT 3.5.1 or later, all the tasks you can carry out with Sybase Central can be
carried out using Interactive SQL to send SQL statements to the database
server, and using the command-line versions of the Adaptive Server
Anywhere utilities.

& For more information about Adaptive Server Anywhere utilities, see
"Database Administration Utilities" on page 63 of the book Adaptive Server
Anywhere Reference Manual.
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Navigating the main Sybase Central window

This tutorial introduces the Sybase Central user interface. It also describes
how to start Sybase Central, how to connect to a database, and how to view a
database schema in Sybase Central.

After completing the tutorial you should feel comfortable exploring Sybase
Central by yourself.

Start Sybase Central

¢ To start Sybase Central in Windows 95 or Windows NT 4.0, select
Start> Programs > Sybase > Sybase Central.

¢ To start Sybase Central from Windows NT prior to Version 4.0, double-
click Sybase Central in the Adaptive Server Anywhere Program
Manager group.

The main Sybase Central window appears.
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Navigating the main Sybase Central window

The Sybase Central window is modeled after the Explorer in Windows 95
and Windows NT 4.0. The main window is split into two vertically-aligned
panels. The left panel displays a hierarchical view of database objects or
containers in a tree-like structure. A container is a database object that can
hold other database objects, including other containers. Sybase Central is at
the root of the tree. Plug-ins for Sybase Central, such as the Sybase Adaptive
Server Anywhere database management system, occupy the first level after
the root level.

The right panel displays the contents of the container that has been selected
in the left panel. The contents of a container can be viewed in the right panel
in several ways: as large icons, small icons, as a list, and alongside their
associated details. You can switch between these views by clicking the
buttons on the Tool Bar immediately below the Window menu.

Connecting to a database from Sybase Central
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This section describes how to connect to the sample database using the user
ID DBA and the password SQL.

Logging on

The sample database contains the user ID DBA, a user with full
administration and resource creation rights. The password for this user is
SQL.

By default, all newly-created Adaptive Server Anywhere databases
contain this user ID and password. It is the responsibility of the database
administrator to provide the desired level of security by changing
passwords and creating other user IDs.

< To connect to the sample database:

1 Start the sample database (asademo.db) by selecting the Personal Server
Sample menu item from the Sybase Adaptive Server Anywhere 6.0
menu. Select Start>Programs> Adaptive Server Anywhere
6.0>Personal Server Sample.

The Adaptive Server Anywhere server and sample database must be
running for any of the following steps to work properly.

2 From the same Sybase Adaptive Server Anywhere 6.0 menu, start
Sybase Central by clicking the Manage Adaptive Server Anywhere
menu item.
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3 On the Sybase Central toolbar, select Connect> Adaptive Server

Anywhere from the Tools menu.

4  Enter the user ID DBA and the password SQL, and click OK.

Connect to Adaptive Server Anywhere EE3
Login | Databasel Netwnlkl .t’-‘-.dvancedl
" |se inteqrated login
& Syupply user ID and password
User(D: I
Pazzword: I
Chooge an ODBC data source to supplement the
connection parameters:
ODEBC data
SOUICE hame: |<None> ﬂ
ODBC data
zource file: I
Browsze. . |
ak. I Cancel |

You can save connection parameters as connection profiles to avoid
retyping often-used connection parameters. For information about
connection profiles, search the Sybase Central online help index for

Connection Profiles.

Viewing a database schema

Expanding a
database container

A database schema is the collection of all objects in the database. Sybase
Central displays a database schema as a hierarchy of containers and their
contents. This section describes how to view the schema of a database.

There are a variety of methods for viewing the objects in a database,

including the following.

¢  Click a container in the left panel to select that container. The right panel
then shows the contents of the selected container. Among the contents of
the server container are all the databases you've attached to, including
ones you have not yet connected to by entering a user ID and password.
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Navigating the main Sybase Central window

¢ Click once on the plus or minus sign next to containers in the left panel
to expand or collapse the hierarchical tree of objects. This allows you to
view database objects at levels below the level of the currently selected
container. If no plus or minus sign appears next to a container it contains
no objects extending beyond the level of that container.

¢ Press the plus or minus keys on the numeric keypad when the selected
container has a plus or minus sign beside it. This expands or contracts

the container.

¢  Using the right mouse button, click on an object in the right panel and a
pop-up menu is displayed. Choose the Open menu item. If the object is a
container object—one that can contain other objects such as folders—
this causes the object to be selected in the left panel, and displays the
contents of that container in the right panel.

¢ Double-clicking a container in either panel expands the tree in the left
panel and displays the contents of the newly-selected container in the

right panel.

¢ Double-clicking on the container in the left panel expands or contracts
the object's hierarchy in addition to selecting it and displaying its

contents in the right panel.
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Viewing the tables
in a database

The left panel displays container objects only. The right panel displays the
contents of the container object selected in the left panel.

The following illustrates the steps taken to examine the contents of a table
folder in a database container.

< To examine the tables in a database:

1

Select the Tables folder. You may have to expand the server and
database objects in the hierarchical tree in the left panel in order to view
the Tables folder.

Each table in the Tables folder is itself a container. Select a table in the
left panel to reveal the contents of that table in the right panel. Each
table object contains folders for columns, foreign keys, relations,
indexes, and triggers.

. Referenced By - Sybase Central [_ O] x|

File Edit Miew Tools Help

|3 Referenced By | Lilﬁl r}éllﬁ.l X|| len..
i1 Caonnection Profiles =]

EQ asademo
- Statistics

E[i asademo (dba)
=0 Tahles
-8 contact

=-E8 customer

| Creator
DBA

MName
FHsales_order

=-EH department
=8 employes
=-E8 fin_code
=-EH fin_data
=8 product
=B sales_order

0 Columns | Y o

B

Expand the table object in the left panel to reveal its contents in the
hierarchical tree. Select each object in the table container by clicking on
it once in the left panel. The right panel will display the contents of the
table object selected in the left panel.
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Navigating the main Sybase Central window

Viewing database
object properties
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The properties of database objects such as a database or stored procedures,
can be viewed using any of the following methods. In all cases, a tabbed
dialog box called a property sheet will be displayed, revealing all editable
and non-editable properties.

¢

Using the right mouse button, click on a database object. From the pop-
up menu choose Properties.

While holding the Alt key, double-click a database object in the right
panel.

With a database object selected in the right panel, press the Alt and
Enter keys simultaneously.

With a database object selected in either the left or right panel, choose
Properties from the File menu.

You can navigate a database by clicking or double-clicking in either panel.
Explore the contents of the other folders in the database. Every Adaptive
Server Anywhere database contains individual folders for the following:

¢
¢

* & & o o

Tables Base tables stored in the database.

Views Computed tables, stored in the database as a query and
evaluated when accessed.

Procedures & Functions for using a module-based language
consisting of SQL procedures.

User & Groups for administering who is permitted to use the
database.

Integrated Logins for enabling users to connect to a database using
their Windows or Windows NT user name and password.

Java Objects for building logic and rich data types into your database.
User-defined Data Types for creating non-standard data types.

SQL Remote for administering replication of data in the database.

DB Spaces for creating more than one .db file for the database.

Connected Users for monitoring current connections to a database.

You should explore the sample database until you are comfortable locating
database objects in the Sybase Central main window.
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Adding a table to a database

This tutorial takes you through the steps adding a table to the sample
database. This task includes adding columns to an existing table. The tutorial
covers the following interface skills:

¢ Using the table editor to add tables and columns
¢ Using property sheets to add new object properties
¢ Using drag-and-drop techniques to add new objects

To add a table to your database you define the name and properties of your
table its columns using a tool called the table editor. The table editor displays
the table columns and their properties in a spreadsheet-like grid. When these
definitions are saved, the table is created.

Creating tables and adding columns in Sybase Central

.
o

Tables are added or edited using the table editor, which displays column
properties in a grid: column properties are displayed along the top of the grid
while the columns are identified by rows, one for every column in the table.

In this tutorial we create a table in the sample database. The new table will
describe different offices for the sample database.

To create a table and columns:

1 Select the Tables folder in the left panel. This can be done by first
expanding the server and database containers, then clicking on the
Tables folder.

2 Double-click the Add Table object in the right panel, causing the Table
Editor to appear.

@& Table <Unnamed> - Sybase Central

MName: I(Unnamed) Creator; Iﬁ dba j _I _>
Ke Column Mame Data Type Size/Frec. Scale Allow MNulls
o]
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Adding a table to a database

Type the name for the table in the Name text box in the upper left corner
of the table editor. In this case, use the name office.

Click in the Column Name column of the first row to enter the name of
the first column in the table. Use the name office_id.

Under the Data Type column choose smallint from the drop down list of
standard data types.

Do not make any entries under the Size/Precision, Scale and Comments
columns. Ensure the entry under the Allow Nulls column is left
unchecked so this column can later be used as a primary key.

2l 2l

we MNulls | Com|Advanced Table Perenies|

Click the Advanced Table Properties button on the toolbar and enter the
comment Company offices in the Comment text box. Comments are an
optional property.

Finish creating the table by clicking the Save and Close toolbar button.
The table editor disappears and the office table is added as another table
in the Tables folder. It can be viewed in the right panel by selecting the
Tables folder in the left panel.

The following section describes how to edit an existing column and add a
primary key to the table using the table editor.

Editing existing tables using the table editor
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This section describes how to edit an existing table. The following steps will
add a primary key to a table created in the previous section named office.
This will be accomplished by turning a column named office id into a
primary key. This column holds a numerical ID for each office.

< To edit an existing table using the table editor:

In the left panel, select the office table. You may have to expand the
server, database and the Tables containers to view the office table.
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Using the right mouse button, click on the selected office table to
display the pop-up menu for the table object and select the Edit Columns
menu item (the same menu item is also available under File menu on the
menu bar). This causes the table editor to appear, displaying one row for
every column in the table.

Click once on the office_id row, under the Key column. The icon
changes to show the column named office_id is now also the primary
key for the table named office.

Primary key conditions

If a check box appears under Allow Nulls column, or if duplicate
values are stored in the office_id column, the column cannot be
changed to a primary key.

Click the Save toolbar button to commit the changes to the office table.

Click the Add Column toolbar button to create another row in the table
editor grid. This adds another column in the office table.

Edit the properties of the new column so that it's name is office_name,
its type is char, its size is 20 and its value can be equal to null.
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Adding a table to a database

@ Table office - Sybase Central

MName: IDﬁice Creator: Iﬁ DBA j
ke | Column Mame | Data Type Size/Frec. | Scale | Allowy My
LAl |office_id smallint =

7  Click the Save and Close toolbar button to commit the changes and close
the table editor.

The column is now present in the database, although it has no data. Sybase
Central does not include facilities for data entry.

Dragging a column to a new table using Sybase Central
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This section describes how to add a column to the office table created in a
previous section to hold the address of each office. The customer table in the
same sample database already has an address column, which can be copied
and added to the office table. These steps will copy the attributes, including
the name, of a column in one table to another table, but will not copy data
from one table to another.

To drag a column to a table:

1 In the left panel, click and expand the customer table to expose the
Columns folder. You may have to expand the database container and the
Tables folder to do this.

2 Select the Columns folder. The right panel will adjust to display the
columns in the customer table.

3 Click the address column in the right panel, and drag it to the office
table in the left panel. The Copy Column Definition window is
displayed.

4  Click OK to add the column to the office table. It will have the same
attributes as the address column of the customer table but will contain no
data.

5 To see the new column, select and expand the office table in the left
panel, then select the Columns folder. The right panel will display the
columns of the office table. The newly-added address column should be
visible in the right panel.
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Notes

6 To see the attributes of the address column, double-click the address

column in the right panel. The address properties sheet appears.

address_copy Properties EE3

General | Data T_l,lpel Eonstraintsl

Iaddress_cnpy

Type: Colurn
Tahle: officel
Comment; ;I

|

0K I Cancel | Ay |

Change the name of the column to office_address by typing this in the
Name text box and click on apply to accept the change. This
modification applies to the address column of the office table only. Once
a column has been copied there is no longer any connection between the
original column and the new column.

Drag and drop is available for several kinds of database management
tasks. For example, you can add users to user groups by dragging, or
drag a table to another table to create a foreign key relationship.

Property sheets are used extensively in Sybase Central. For example,
property sheets are used for users, stored procedures and individual
columns.

Add Object icons are used to add other objects besides tables to a
database. Stored procedures, triggers, indexes, users, user groups, and
columns are among the database objects that you can add with an Add
Object icon.

Pop-up menus are available throughout the Sybase Central interface by
clicking on objects or in windows using the right mouse button.
Showing an object's pop-up menu is a convenient way of finding out
what actions can be carried out on an object.
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Adding a table to a database

Deleting tables using Sybase Central

Tables can be deleted, or dropped, from a database. The office table created
in a previous section can be dropped from the sample database, restoring the
database to its original state.

< To delete the office table from the sample database:
1 Using the right mouse button, click the office table.

2 Select Delete from the pop-up menu. A Popup appears allowing you to
accept the deletion.
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Viewing and editing procedures

Stored procedures are kept in a folder within the database container object.
This tutorial shows how to view and alter the contents of a procedure, and
how to create new procedures using the Sybase Central code editor.

The Sybase Central code editor is a separate window for displaying and
editing the code of triggers, procedures, and views.

Beyond text-editing functions, it provides:

¢

¢
¢
¢
¢

Automatic syntax highlighting.

Automatic formulation of DDL statements.

Unlimited Undo and Redo.

Ability to find and replace text, and to jump to specific line numbers.

Ability to execute the DDL code against the database.

Viewing stored procedure code with Sybase Central

There are several stored procedures included in the sample database. The
following steps explain how to view and edit stored procedures.

% To view the contents of a procedure:

1

Select the Procedures & Functions folder from the sample database in
the left panel. You may have to expand the database container to do this.

In the right panel, double-click sp_customer _list in the right panel. The
Sybase Central code editor appears, displaying the text of the procedure.
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Viewing and editing procedures

# Procedure 'sp_customer_list' (Watcom-SQL) - Sybas... M= E3
File Edit Miew Search Help

|6 wa| 4[B(@] X| o[~ Al&]a] =] o

alter procedure =l
"dba".sp_customer_list()
result({”id” integer,company_name char(35))
begin
select "id"”,company_name from customer
end|
4| | _’l_l
| B Lines Line: B Caol: 4 | | y

3 A call to this procedure returns a set of customer IDs and company
names from the Customer table.

Viewing Adaptive Server Anywhere supports two syntaxes for stored procedures. The

procedures in native Adaptive Server Anywhere syntax (Watcom-SQL) is based on the

Watcom-SQL or ISO draft standard. Adaptive Server Anywhere also supports the Sybase

Transact-SQL Transact-SQL syntax. You can enter procedures in either syntax, and
Adaptive Server Anywhere can automatically translate between the two
syntaxes.

Not all procedure statements may translate. Untranslated statements appear
as comments in the translated procedure.

< To view the alternative syntaxes of a procedure:

1 With the right mouse button, click on the sp_customer_list procedure.
A pop-up menu appears.

2 Click Open to view the procedure in the syntax in which it was entered.
This is the syntax in which the procedure is stored in the database.

3 Click Open as Watcom-SQL to view the procedure in Watcom-SQL
syntax.

4  Click Open as Transact-SQL to view the procedure in Transact-SQL
syntax.

Notes ¢ The Sybase Central code editor is used to display and create views and
triggers as well as stored procedures.
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Setting Stored procedures have permissions associated with them. In order to
permissions on execute a procedure you either need to be granted permission to execute a
procedures procedure, or you need to be a member of a user group that has permission to

execute the procedure.

< To view and alter the permissions on a procedure:

1 Using the right mouse button, click on the sp _customer list procedure.
A pop-up menu appears.

2 Select Properties from this menu. The properties sheet for
sp_customer _list appears.

3 Click the Permissions tab to see which user IDs have been granted
permissions on this procedure. Currently none do, as the only user for
the sample database is DBA, who automatically has execute permissions
as owner of the procedure.

sp_customer_list Properties ﬂﬂ

General Permissions |Parameters|

A”DW o mm m b b bl -
st Grant Permission [ 7] x]
MNarm  Users:
Mame | B... |
£ DBEA
ﬁdbu ute |
€& PUBLIC
I Grant Permission Cancel
T T =l

4  Click the Grant Execute button to grant users or groups permission to
execute this procedure. Grant permission to execute this procedure to the
Public user group by selecting the Public user group icon and clicking
the Grant Execute button.
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Viewing and editing procedures

5 Click the OK button to accept the changes to the sp_customer _list
permissions or Cancel to undo the changes.
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Managing users and groups

In Adaptive Server Anywhere, both users and groups are objects within the
database. However, groups are also containers, capable of containing users
(making users a member of that group) and other groups.

In this structure, permissions granted to a group are inherited by those users
and groups which have membership in the group. Adaptive Server Anywhere
allows you to create users and groups permitted to use a database and grant
membership to groups. Also, users and groups can be members of multiple
groups.

This tutorial demonstrates how to create a group for the database, create an
individual user, and make the user a member of the group.

Adding a group to the database

In this section we add a sales group to the sample database.

% To add a group to a database:

1 Select the Users & Groups folder in the left panel. You may need to
expand the sample database container in the left panel to do this.

2 Double-click Add Group in the right panel. The Create a New Group
wizard appears.

Ths sz @l o yeoi b Copmha & 8 o QT p bor B o dataibassg

‘Whad i the e of e rerw groep?

‘b 12: Hhes pam s o the nsss groupY
Parmword: |
Conkirs |
F LUserGroag = allowsed o coneacd

| | [ comca |

3 Type the name Sales in the top text box. This is the name of the user
group.
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Managing users and groups

4  Enter a password (for example, Sales), confirm it by entering it again,
and click Next to show the following page of the wizard.

5  Check the Resource authorities option, and uncheck the DBA and
Remote DBA option, for this group. Then click Next to show the
following page of the wizard.

6  Click Finish to create the new group.

The sales group appears in both panels. Groups are container objects, and so
appear in the left panel.

Adding a user to the database

This section describes how to add a user to a database.

« To add a new user to the sample database:

1 Select the Users & Groups folder in the left panel. You may need to
expand the sample database container in the left panel to do this.

2 Double-click Add User in the right panel. The new user wizard appears.

Wil c i 0 e Ligar Craamon winard. This sdzond alows yo o
creale o reny unEr on e dotntsaae
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3 Type the name Sandy in the top text box. This is the user ID for the new
user.

4  Type a password, and confirm it by retyping it. For example, you could
use the password Sandy. Then click Next to show the following page of
the wizard.
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Follow the instructions to complete the wizard choosing the default
options.

An icon appears in the right panel, showing the new user. There is no
icon in the left panel, as individual user ID's are not containers.

Adding a user to a group

Restoring the
sample database
to its original state

Sybase Central provides two ways to add a user to a group. You can use the
individual user's Properties sheet, which has a Membership tab. Or you can
use a drag and drop method.

In this section we add two users to a group using drag and drop.

To add users to a group:

1

2
3
4
5

Ensure that the Sales group is shown in the left panel and that the users
DBA and Sandy are shown in the right panel. You may need to select
the Users & Groups folder to do this.

Click Sandy to select this user.
While holding down the Ctrl key, click DBA to select this user as well.
Click and drag the users to the Sales group in the left or right panel.

Select the Sales group in the left panel to show its members.

To restore the database to its original state, you can delete the Sales group
and the user Sandy. For each of the two icons:

1
2

Using the right mouse button, click the icon.

Select Delete from the pop-up menu and acknowledge the deletion.
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Backing up a database using Sybase Central

Backing up a database using Sybase Central

Sybase Central includes a set of database utilities for carrying out common
database administration tasks. Wizards are provided to help carry out the task
step-by-step.

To see all the database utilities provided with Sybase Central, click the
Database Utilities folder at the top of the left panel. A list of the utilities
appears in the right panel.

? Utilities - Sybase Central
File Edit %iew Tools Help
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Some of the utilities are used on database files, while others can be used with
running databases. Those utilities that can be used on a running database are
shown on a pop-up menu by right-clicking on the database icon. In this
lesson, we back up the sample database.

.

% To back up a running database

1 Using the right mouse button, click the sample database and select
Backup from the pop-up menu. The Backup Wizard appears.

2 You do not need to alter anything on the first page of the wizard. Click
Next to move to the second page.
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3 Type a directory in the text box indicating where you wish to back up
the database to. As this is a tutorial only, you may wish to choose a
temporary file directory such as c:\temp.

4 Check the Main Database File and Transaction Log File options, and
uncheck the Database Write File option. Then click Next to take you to
the next page of the Wizard.

5  Select the option Continue To Use The Original Transaction Log from
the three options presented, and click Next to take you to the next page
of the Wizard.

6  Review the choices you have made, and click Finish to back up the
database. A window displays the progress of the backup.

Wizards are available for several other database administration tasks. You
may wish to try creating a database by selecting the Database Utilities folder
in the left panel and then double-clicking the Create Database tool in the
right panel.
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Using the Sybase Central online help

Using the Sybase Central online help

The main documentation for Sybase Central is available as online help
separate from the main Adaptive Server Anywhere online documentation.
This tutorial introduces you to the Sybase Central online help.

The online help is presented as a set of topics. You can find topics about a
subject of interest using the Contents, the Index, or by searching the text of
the online help.

Using the online help Contents

< To see the Sybase Central online help contents:

1 Select Help> Adaptive Server Anywhere Plug-in Help from the Sybase
Central Help menu. The Sybase Central Help Topics window appears.

2 The Help Topics window has three tabs: Contents, Index, and Find.
Click the Contents tab.

Help Topics: Sybase Central for Adaptive Server Anywhere HE

Contents | ndex | Find |

Click a book, and then click Open. Or click another tab, such as Index.

ZFntrocuction t

& Connecting to a Datahase

& tanaging Servers
hanaging Databases

& Using the Adaptive Server Amywhere Service Manager

& Using the Adaptive Server Amywhere Utilities

L3 tanaging Tables

& tanaging Indexes

& kanaging Triggers

L Managing Wiews

L tManaging Procedures & Functions

& tanaging Java Objects

& Managing Users & Groups

& tdanaging Integrated Logins

& tanaging User-defined Data Types

* tdanaging S0OL Remote Replication

& tanaging Database Spaces =

hanaging Connected Users
[ et Ry, LI

Open | Erint... | Cancel |

|»
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Notes

The online help Contents are displayed as a set of books. To open a book,
click the book and click Open or double click a book. The following example
illustrates the organization of the help topics.

To find out how to add a group:

1 With the Contents tab showing on the Help Topics window, click
Managing Users & Groups to open the book.

2 Click Creating A New User Or Group to display the topic.

¢ Many topics have a Related Topics link at the end of the topic, which
can take you to related topics in the Sybase Central online help and in
the online version of this book.

¢ You can use the Browse buttons (with arrows) to take you back and
forward through related topics.

¢ You can configure some aspects of the appearance of the online help by
clicking Options.

¢ Clicking Help Topics opens the Help Topics window again.

¢  Click on Adaptive Server Anywhere Master Help in the Help menu and
select the Adaptive Server Anywhere User's Guide.

You should spend some time browsing through the Contents window to
familiarize yourself with the online help organization.

Using the online help Index

Notes

The Index provides an alternative way to search for information in the online
Help.

This section shows how to find information about creating users using the
index.

To find a topic using the Index:

1 Open the Help Topics window, and click the Index tab.

2 Type "users" in the box numbered 1. In box 2, the first user entry is
highlighted.

3 The index is a two-level index. Click Creating under Users, and click
Display to show the topic.

If there is more than one topic indexed under the entry you display, a list of
topics is displayed.
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Searching the text of the online help
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If you cannot find the information you are looking for using the Contents or
the Index, you may want to try searching the text of the online Help.

To find a topic by searching text:

1
2

Open the Help Topics window, and click the Find tab.

When you have built your word list, type "user" in the box numbered 1.
As you type, a list of matching words is shown in the box numbered 2.

Click user in box 2.

Click Creating a new user Or Group in the topic list in box number 3,
and click Display to show the topic.



